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1. General Information 

This section will introduce the user to the Trinity School Scheduler (TSS) User Interface (UI), 

the Trinity Scheduling Integer Program (IP), and the Output Interface.  

1.1 System Overview 
Trinity School at Meadow View currently creates semester schedules by hand which is a time 

intensive process that can take them days or even weeks to complete The Trinity School 

Scheduling Tool was created to ease the scheduling process for Trinity. The tool finds feasible 

schedules for future school semesters given a variety of input parameters and creates a cohesive, 

clear master schedule. The tool is supported by Windows OS. The tool uses Microsoft Access, 

Microsoft Excel, and NEOS, a free internet-based service for solving numerical optimization 

problems.  

1.2 Organization of Manual 
The User’s Manual consists of five sections: Getting Started, The TSS User Interface, The 

Trinity Integer Program, The Output Interface, and Trouble Shooting.  

Getting Started explains how to set-up and open the Trinity School Scheduling Tool. 

The TSS User Interface section gives directions on how to use the UI and describes all of its 

features.  

The Trinity Scheduling Integer Program section gives a high level of the IP used to solve the 

scheduling problem and how to run the IP using the NEOS sever. 

The Output Interface section provides instruction on how to import the solution file and how to 

get the master schedule output.  

The Trouble Shooting section offers advice to avoid infeasibility.  
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2. Getting Started 

The user has been provided a flash drive or CD/DVD with the Trinity School Scheduling Tool 

and all relevant documentation. The contents of the flash drive or CD/DVD are found in Table 1.  

The TSS User Interface TSS.accdc 

The Output Interface TSS_OutputUI.xlsm 

LP Solve Software Lpsolve.exe 

User’s Manual UsersManual.pdf 

Trinity Scheduling Final Report TS_FinalReport.pdf 

Trinity Scheduling Final Presentation TS_FinalPres.pdf 

Table 1: Flash Drive or CD/DVD Contents 

Extract all contents of the flash drive or CD/DVD and save it all in a single folder. Read through 

the entirety of the User’s Manual before attempting to use the Trinity Scheduling Tool. Read 

through the Final Report to understand the motivation behind the tool and the reasoning for the 

selected solution method.  
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3. The TSS User Interface 

The TSS User Interface will be the first step in creating a master semester schedule. Begin by 

gathering all required data: 

 Teacher names 

 Teacher assignments for all sections 

 Teacher availability for the 6 periods 

 Teacher full/part-time status 

 Section sizes for current student body 

 Classroom names 

 Classroom capacity 

 Classroom content  

 Classroom availability  

Now, open the TSS User Interface in Microsoft Access (make sure to enable content). This is the 

homepage:  

 

Complete the following steps to ensure all data is entered: 

1. Select the semester that needs to be scheduled by using the drop-down menu next to 

Semester. 

2. Enter Section Information by clicking the respective button and entering data into the 

table. Click Save. Click Back to return to the Homepage. 
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3. Enter Teacher Information by clicking the respective button and entering data into tables.  

a. Create a row for every teacher.  
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b. For every teacher, enter his/her availability and choose his/her full/part-time 

status by clicking Edit Schedule. Click Done to save and return to the Teacher 

Information homepage. 

 
c. For every teacher, choose his/her class assignments by clicking Edit Sections. 

Click Save. Click Done to return to the Teacher Information homepage. 



Scheduling for Trinity School – User’s Manual  December 9, 2016 

George Mason University 7 SEOR Department 

 
d. At a maximum four classes should be assigned to full-time teachers and a 

maximum of two classes should be assigned to part-time teachers. Every class 

should only be assigned to one teacher.  

e. Click Close to save and return to the Homepage. 
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4. To edit the room constraints, click on the Enter Room Constraints button and directly edit 

the capacity of each room. 
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a. Click on the Edit Content button for a room to edit the content available in the 

selected room. If a room can hold all types of classes, select all classes in the list.  

5. All data has been entered. The data will be saved for later use. Remember, separate 

installations do not speak to each other. 

6. Keep the TSS UI open and proceed to The Trinity Scheduling Integer Program section. 
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4. The Trinity Scheduling Integer Program 

Once the user has entered all required data, the IP is ready to be created. On the TSS UI 

Homepage, in the schedule section, use the drop-down menu to select which IP you would like to 

run. There are two options:  

1. Random: This will create a randomized objective function, and could result in different 

schedules being produced each time it is used.  

2. Distance: This will set the objective function to maximize distance students travel 

between classes to encourage exercise and to stimulate the mind for the next class. 

Please select one, and proceed: 

1. On the TSS UI homepage, press Solve! to create a .LP file containing the IP formulation 

with the user-entered data. 

2. This will create a file called “TSS.lp” in the same folder as the TSS UI. Open this file 

using LPSolve 

3. Click the Save As button and save the file as a .MPS file. You can rename the file at this 

time, but we suggest keeping it named “TSS.mps” and overwriting any previous versions. 

4. Save this file to the folder with the Trinity School Scheduling Tool. 

5. Navigate to: https://neos-server.org/neos/solvers/lp:Gurobi/MPS.html 

6. Upload the .MPS file you just saved: 

 
7. Now, check the “Return .sol file:” box to include the solution file as part of the results. 

https://neos-server.org/neos/solvers/lp:Gurobi/MPS.html
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8. Scroll down and enter a valid email address where the solution file and results can be 

sent.   

 
9. Click “Submit to NEOS”. After the IP is done running, the solution file will be sent to 

email address provided. This could take a few seconds to a couple hours depending on 

how constrained the problem is.  

10. When the email arrives, open it, copy all of the solution results. The output begins after 

********** Begin .sol file ************* 

a. If the results say infeasible or show an error, please go to the Trouble Shooting 

section of this User’s Manual. 
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11. Paste the results in to a .txt file using Notepad. Save this file as IP_Output.txt. 

12. The IP has successfully solved, proceed to The Output Interface section.  
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5. The Output Interface 

These are the final steps of the Trinity Scheduling Tool. Begin by opening the, 

TSS_OutputUI.xlsm and Enable Editing and Enable Content. This is the Homepage: 

 

5.1 Create a New Schedule 
1. The Output Interface requires a few set-up steps upon first use, use on a new computer, or 

if the corresponding files have been moved to a new location on your computer.  Set-up 

steps can be found in the “Output Interface Set-up” section below.  Otherwise, proceed to 

step 2 to begin creating a schedule. 

2. If changes have been made to inputs in the Access database update the section, teacher, 

and classroom lists in excel by clicking Update All Tables. 

a. To review lists individually click the corresponding Edit button.  Update the list 

automatically by clicking the update button.  If no changes are needed, return to 

the homepage by clicking Go to User Overview.   

b. If you get a path not found error, go to “Output Interface Set-up” below.  

3. Next, click Clear Schedule to ensure there is a blank slate to work with. 

4. Click Update File Path and upload the IP_Output.txt file created in the last section. 

5. Click Create Master Schedule.  It may take a few minutes to complete. 

6. Once the Create Master Schedule macros finish executing, click Go To Master Schedule 

to view the semester schedule that was created.  A few additional options will become 

available on the right of the Master Schedule (see below image for options). 

a. The user has the option to export the schedule into another Excel workbook by 

clicking the Output to New Excel WB button. 

i. This is where you can schedule alternating classes, Transfer Latin, and 

make any final changes to the master schedule.  

b. The user has the option to create a teacher schedule with the Create Teacher 

Schedule button, which will appear on a new tab.   

c. The basic master schedule can be output to a PDF using the Output PDF button. 
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7. The Trinity Scheduling Tool has been used to completion. Proceed to the Section 6 for 

Trouble Shooting tips. 

5.2 Output Interface Set Up 
The Output Interface requires a few set-up steps upon first use, use on a new computer, if the 

corresponding files have been moved to a new location on your computer, or in the event you get 

an error when clicking any of the Update List buttons. These set up steps do not need to be 

completed upon every use. The tool needs to know the path to the database in order to pull data 

from it. The macro responsible for each list will need to be updated. The following steps will 

guide you: 

1. To update macros, the developer tab must be available in the toolbar.   

a. Click Options from the File menu on the toolbar. 

b. The excel options window will appear.  Select Customize Ribbons.   

c. On the Main Tabs section, select Developer.  Click ok. 

d. Verify the Developer tab is available in toolbar.  Refer to online resources for 

further help if troubleshooting is necessary. 

2. Navigate to the Developer tab and click the Macros button .  The Macro window 

should appear. 

3. Next, select createConnectionClassroom and click Edit.  The Microsoft Visual Basic 

Window will open. 
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4. The highlighted code below (“Data Source = Your Updated Path Here”) needs to be 

updated with the path to the database file on your computer. 

 

a. Open windows explorer. 

b. Navigate to the path where the database file is saved. 

c. Select and copy the path from the address bar (pictured below). 
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d. Paste it into the highlighted section pictured. (“Data Source = Your Updated Path 

Here\TSS v02.accdb”) 

e. This updates the macro to the path of the folder the database is located in.  The 

file name after the highlighted selection should only be changed if the name of the 

database has been changed. 

f. The macro should be updated. Close the Visual Basic Window. 

g. Navigate to the Classroom tab and select Update List to test that Updates were 

made successfully. 

h. Repeat steps for createConnectionSection and createConnectionTeachers. 

i. Once lists have been updated you can proceed to create a new schedule. 
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6. Trouble Shooting 

Here are some tips and tricks to avoid errors: 

1. Make sure every class has only one teacher assignment. 

2. Make sure sections sizes are correct, it is easy to hit extra numbers. 

3. Make sure that at a maximum four classes are assigned to full-time teachers and a 

maximum of two classes are assigned to part-time teachers. 

4. All teachers should be assigned at least one class. 

5. If the Master Schedule has unexpected assignments (Mismatching class/teacher), check 

Access to ensure corresponding input data is correct. 

6. If the Update Lists button creates an error, the path to the database needs to updated so it 

knows where to pull from. Review “Output Interface Set Up”.  

Infeasibility issues will typically be caused by incorrect data or a lack of classroom or teacher 

availability. Use the tips and tricks above to make sure there are no data issues. If there are none, 

go back to the TSS UI and edit the data by increasing the availability of teachers and relaxing 

classroom content restrictions until a feasible solution is produced.  


